1
2

Guide to MapPoint 

Contents

About MapPoint


page 1

MapPoint Basics


page 2

The MapPoint screen

page 6

Drawing tools


page 12

Mapping tools 


page 19

Using demographic data

page 25

Importing data


page 31

About MapPoint

MapPoint is a computer mapping application. It allows you to do a variety of things, including:

· find places or addresses

· plot routes for road journeys

· draw on a map

· map demographic data that comes supplied with the package

· map you own data

Two versions are currently available, one for North America, and one for Europe which is documented here. Each version contains detailed maps for the appropriate region that show roads, places and basic information regarding terrain and political units such as nations or regions. 

MapPoint has a variety of mapping tools that allow users to find specific locations using street names and post codes. It also provides users with drawing tools to allow maps to be customized, and features to be drawn or highlighted. Users can plot routes (on the road system) including precise directions, distances and estimated journey times.

MapPoint uses a Wizard to enable users to plot data on a map. This can either be the demographic data that is supplied with MapPoint, or data imported from a spreadsheet. MapPoint also contains demographic data supplied by Claritas Inc. This contains basic demographic data for the whole world, and more detailed data for most European countries.

MapPoint Basics

This section includes:

· Starting MapPoint

· Opening an existing map

· Saving 

· Printing

· Closing

Starting MapPoint 

These instructions assume that you are using MapPoint on a C&IT resource room machine.

Click on the Start menu, and go to Programs. 

You should now see an option for MapPoint Europe. Click on this.

You may now be asked to confirm a licensing agreement. If so, click on Agree.

MapPoint should appear as illustrated below, showing the British Isles.
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Opening

When MapPoint starts it automatically creates a new map for you to work with. However, it is possible to open map files that have previously been saved and closed.

Go to the File menu.

Click Open. The following dialogue box should now appear:
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Select the disk drive or folder that contains the file that you want.

Select the file itself by clicking on it.

Click on the Open button.

Saving 

Go to the File menu.

Click Save As. The following dialogue box should now appear:
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Ensure that you:

· Choose a place to save you work. Use the Save In menu to select an appropriate drive or folder.

· Give your work an appropriate name. 

Note that MapPoint files have the .ptm file extension.

Printing

Ensure that the area that you want to print is fully visible in the Map pane on screen.

Go to the File menu. Click on Print. The following dialogue box should now appear:
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Check page orientation. Normally Landscape will be most suitable.

Check the Title that MapPoint automatically gives. To change it, simply click into the title text box and alter it.

Use Page Setup to alter margins or paper size, should this be necessary.

Once all of the above have been checked, simply click OK.

Closing

Go to the File Menu.

Click on Exit.

If you have not saved your work, or not saved any recent changes, MapPoint will now prompt you to do so.

The MapPoint Screen

The MapPoint Screen is split into several sections, known as Panes. When you first open MapPoint, you should see the following:

· Map Pane

· Task Pane

· Toolbars

[image: image5.png]foi e e T
Toolbars —L cu o

Task Pane —} [T

AT
o T S

Drawing
Toolbar =—|





Map Pane

This section looks at how to work with the Map Pane. 

Location and Scale

The Location and Scale toolbar is located along the top of the map pane, and contains information about the current location being displayed, and the current scale of the map.
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Scale. This is shown on the right of the ruler. The scale automatically alters according to the level of magnification currently being used. 

It can be shown in either miles or kilometres. To change between them:

Go to the Tools menu. Select Options. The following dialogue box should now appear:
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Select Miles or Kilometres and click OK.
Location. This is shown by the main section of the ruler, and shows information about the area currently displayed in the Map Pane, broken down into relevant geographical categories such as Country, region, city and so on, according to the level of magnification. 
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Tools

This section looks at toolbar tools that control the map pane, including:

· Pan

· Select

· Zoom

· Back and Forward buttons

· Map Style menu

The Pan tool

	The Pan tool enables you to make small movements in the Map pane. Click on the Pan tool button in the toolbar:  
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· The mouse cursor should now change to a hand with one finger outstretched. 

· Move the cursor in the direction in which you want to move your view of the map. 

· Hold down the left hand mouse button. You should now find that the cursor has changed so that the hand now shows all fingers. 

· Drag towards the opposite side of the map. You should find that the view of the map moves with the cursor.

The Select tool

The Select tool enables you to select a particular area of a map, and increase magnification to see greater detail. 

	Click on the Select tool in the toolbar:  
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· The mouse cursor should now change to an arrow with the outline of a box around its point. 

· Use the cursor to drag a rectangle around the area that you want to select (if select the wrong area, click outside of the rectangle and try again). 

· Now click within the boundaries of this rectangle. 

· You should find that the map pane now shows the selected area in greater detail.

The Zoom tool

The Zoom tool comprises three buttons that control the level of magnification of the Map pane.
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Minus magnification 
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  Click this button to decrease magnification.

Magnification slider
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	Drag the slider bar to the right to increase magnification, or to the left to decrease it.


Plus magnification
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	Click this button to increase magnification, centred on the current view of the map.


Back and Forward buttons

These buttons work in the same way as the back and forward buttons in a web browser.
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Click the back button to see the last view of the map, and click the forward button to see views that you have already been to. These buttons are linear. In other words, if you have viewed ten different places on your map, clicking the Back button ten times will take you through each one, in the reverse order of which you visited them.

Map Style menu

MapPoint enables maps to be viewed in one of the five following styles. 

· Road

· Road and Data

· Data

· Political

· Terrain

Click on the Map Style menu, and simply click on the option that you want.
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Be warned that the level of detail implied by each is not that great. For example, the Political map of the U.K. simply shows boundaries between England, Scotland and Wales, although detail is slightly better for other European countries.

Task Pane

The Task pane is split into two sections:

· Overview map

· Legends

Overview map

The Overview map is located in the top left hand corner of the screen. 
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It allows you to quickly change the area shown in the Map Pane. The Overview Map contains a blue rectangle. This corresponds to the area shown in the Map Pane. By dragging and moving this rectangle it is possible to quickly change the  main map view.

Note that the size and shape of the blue rectangle may change when you alter the magnification in the Map Pane, as shown below.
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Legends

Legends are split into five sections:

· Populated Places

· Boundaries

· Transportation

· Parks and Reserves

· Miscellaneous

Note that other sections may appear if appropriate to the needs of your map.

To view a section, click on the appropriate cross (shown to the left of each title). The legend should "expand", and the cross should turn into a minus sign.  To return an expanded section to the way it was, click on the minus sign.
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Drawing tools

This section covers the use of drawing tools. These tools can be used to highlight areas or points on a map, and text boxes can be added to display information. Technically Pushpins fall into this category, but are covered in the next section (Mapping Tools) because they can be used to store and map data in addition to their use as visual reference points.

The Drawing tools toolbar is located at the bottom of the MapPoint screen:
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Shape Tools

When using any of the Shape tools described below it is always a good idea to ensure that the map you are working with covers the complete area that you want to work with before starting, if possible.

Highlight

The highlight tool allows you to draw free-form lines on a map. 
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Click once on the highlight button (above).

Freehand

Move your mouse cursor to the first point on the line or border that you want to highlight.

Hold the mouse button down and drag the line or outline that you require. 

At the end, double click to confirm that the highlight is complete.

Point to Point

Move your mouse cursor to the first point on the line or border that you want to highlight.

Single click with the mouse, and move the cursor to the first point or bend in the highlight that you want to draw. 

Single click again, and you should find that MapPoint plots a straight line between the two points on the map where you clicked. 

Repeat this process until the highlight is complete.

Using either of these methods will produce a freehand shape or line that contains a series of small square markers. These markers are known as edit points.

Altering and editing a highlight

By clicking and dragging on edit points it is possible to alter the shape and size of a highlight.

It is also possible to add or delete edit points. Click with the right hand mouse button at the appropriate point on the highlight, and a floating menu will appear with the Delete point or Add point command. 

To change colour or line thickness, see the next section Alteration Tools.

Scribble
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The scribble tool works in a similar way to the highlight tool. However, it lacks the ability for straight (point to point) lines to be drawn and does not show distances. To use it, follow the Highlight Freehand instructions above.

Line and Arrow

[image: image23.png]N




Click once on the line button or arrow button (above).

Move the mouse cursor to the point on the map where you want the line or arrow to start.

Hold down the lefthand mouse button and drag to the point on the map where you want the line or arrow to terminate. 

Let go of the mouse button. You should find that a line or arrow has now appeared, with a white box (resize handles) at each end. 

Altering a line or arrow

By clicking and dragging on these resize handles it is possible to alter the length and angle of an arrow or line. 

To move an arrow or line, place the mouse cursor over it and click once to select it. The mouse cursor should change to a cross. Simply drag with the mouse to a new position on the map.

To change colour or line thickness, see the next section Alteration Tools.

Freeform
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The Freeform tool works in the same way as the highlight tool, but produces a closed shape rather than a line. 

Rectangle and Oval
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Click once on the Rectangle button or Oval button (above).

Move the mouse cursor to the area where you want the shape to appear, and drag diagonally in the most appropriate direction. 

Once you have the size and shape that you want, let go of the mouse button. The rectangle or oval should now appear with eight white squares (resize handles) appearing at the extremities. 

Squares and Circles

To create a square or perfect circle, hold down the shift key while dragging with the mouse.

Altering a rectangle or oval

By clicking and dragging on the resize handles it is possible to alter the width and height of a rectangle or oval. 

To move a rectangle or oval, place the mouse cursor over it and click once to select it. The mouse cursor should change to a cross. Simply drag with the mouse to a new position on the map. Note that this can be tricky with a transparent or "no fill" shape. These shapes can only be moved by dragging the edge of the shape.

To change colour or line thickness, see the next section Alteration Tools.

Radius
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Click once on the Radius Button (above). The mouse cursor should now change to a cross. 

Move the cursor to the point on the map that you want to be at the centre of  the radius. 

Hold the left hand mouse button down, and drag away from this point. You should find that as you drag, a dark circle appears to indicate the size and location of the radius you want to draw, along with a measurement indicating distance from the centre of the circle.

Once you have reached the radius measurement that you want, let go of the mouse button. The radius should now appear.

Resize the radius

Place the mouse cursor on any of the four white boxes (resize handles) that appear at the four corners of the circle. 

Drag inwards or outwards to alter the size. Note that the measurement of the radius alters accordingly.

Move the radius 

Place the mouse cursor over the centre of the radius. The cursor should change to a four way arrow. Now simply drag the radius to the new location.

Textbox
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Click once on the Textbox button (above).

Move the mouse cursor to the area where you want the textbox to appear, and drag diagonally in the most appropriate direction. 

Once you have the size and shape that you want, let go of the mouse button. The Textbox should now appear with eight white squares (resize handles) appearing at the extremities. A flashing text cursor should appear at the top left hand corner of the textbox.

You are now ready to type your text. Once you have finished typing, click into the background of the map. You should find that the textbox automatically re-sizes itself according to the amount of text you have put it.

Altering a Textbox

By clicking and dragging on the resize handles it is possible to alter the width and height of a textbox. 

To move a textbox, place the mouse cursor over it and click once to select it. A "fuzzy" border should appear. Place the mouse cursor over this border and drag with the mouse to a new position on the map. 

To change colour, text colour or line thickness, see the next section Alteration Tools.

Alteration Tools

It is possible to alter the colour and thickness of any shapes created with the drawing tools described above. Each of the tools described below can be used to alter the appearance of any of the shapes described above unless otherwise stated.

Fill colour

Note that Fill colour does not apply to lines or arrows.

Select the shape that you want to alter by clicking on it once.
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Click on the down arrow of the Fill colour button (above). A palette of colours will appear. 

Click on the colour that you want. You should now find that the area covered by the shape has changed in colour accordingly. 

You should also find that the main section of the Fill tool has changed colour. This enables you to change the fill of more shapes by simply clicking once on this button, rather than having to get it from the palette.

Note - To make the fill of a shape transparent, select the No Fill option from the Palette.

Line Colour

On a shape such as a rectangle or a closed highlight the line colour applies to the border of the shape.

Select the shape that you want to alter by clicking on it once.
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Click on the down arrow of the Line colour button (above). A palette of colours will appear. 

Click on the colour that you want. You should now find that the line or outline of the shape selected has changed in colour accordingly. You should also find that the main section of the Fill tool has changed colour. This enables you to change the line colour of more shapes by simply clicking once on this button, rather than having to get it from the palette.

Text Colour

Note that Text Colour only applies to text in text boxes.

Select the text box that you want to alter by clicking on it once.
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Click on the down arrow of the Text colour button (above). A palette of colours will appear. 

Click on the colour that you want. You should now find that the text has changed in colour accordingly.

Line Style

Note that the only alteration to line style that this tool allows you to make is actually the thickness of the line.

Select the shape that you want to alter by clicking on it once.
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Click on the Line Style button (above). A menu of different line thicknesses will appear. 

Click on the one that you want and the thickness of the line should change accordingly.

Arrow Style

Select the arrow that you want to alter by clicking on it once.
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Click on the Arrow Style button (above). A menu of different arrow styles will appear. 

Click on the one that you want and the arrow should change accordingly.

Mapping tools

This section covers:

· Location sensor

· Measuring 

· Finding

· Push pins

Location sensor

The location sensor displays map positions using longitude and latitude.

Go to the Tools menu.

Click on Location Sensor. A floating window should now appear, as shown here:
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Measuring

The measuring tool is used to measure distances between points on a map. Distances are shown in either kilometres or miles, depending upon which is being used (see page 5).

Before using the measuring tool it is a good idea to get the route or distance that you want to measure on screen at a magnification that is suitable to work with (preferably one that allows you to see the full distance that you want to measure without having to pan to another part of the map).

Go to the Tools menu.

Click on Measuring Tool. The mouse cursor should now change to a cross shape. 

Find the point on the map that you want to start from, and click once. 

Now hold the mouse button down and drag along the route that you want to measure until you reach the finish point. 

Once at the finish point, double click to stop using the measuring tool. You should find that a black line has been drawn along the path you chose, with a series of white squares (edit points), and the final distance displayed at the end, as shown below: 
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Altering a measured route

The measured line that you have drawn can be altered. 

By clicking and dragging the edit points along its length you can change the route of the line to correct or alter its course.

To delete a measured line, simply click on it once to select it (the edit points should appear if not already visible) and press the delete key on the keyboard.

Finding

MapPoint has the facility to locate a variety of different points on a map, from specific addresses to postal areas.

The quickest way to find somewhere is simply to type the address into the Find a Location box in the navigation toolbar, and click on the Find button:
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MapPoint will then look for the information that you have requested. This may take a few seconds to happen, in which case the following dialogue box will appear, with the magnifying glass symbol animated in a circular motion.
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If MapPoint successfully locates the address, it will display it with a Pushpin:
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If it finds several addresses that may be relevant, they will be displayed in a list in the Find dialogue box. It is up to you to select the one you want from this list.

Alternatively, you can alter the details displayed in the Find dialogue box to improve your search (if you do not have it on screen it can be found by going to the Edit menu and clicking on Find).
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Pushpins

Pushpins are used to mark places on a map. They can be used individually, or in groups to indicate sets of data. Pushpins have a symbol to indicate their position on a map, together with a title and a text balloon to show information. 

Create a Pushpin

Click on the Pushpin tool in the drawing toolbar at the bottom of the screen:
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Move the mouse cursor to the point on the map where you want the Pushpin to appear, and click once.

The Pushpin should now appear on the map, with a text balloon with a grey area and white area. The grey area is for the Title of the Pushpin, and the white area is for further information (such as an address). To alter either, simply double click on it and type.

To close the Pushpin balloon, click on the cross shaped marker to the right side of the Title.

Delete a Pushpin

Click on the Pushpin that you want to delete. A black box should appear around the pushpin icon to confirm that you have selected it.

Press the Delete key on the keyboard.

Change the symbol used 

For a new pushpin:

Click on the down arrow to the right of the main Pushpin button in the toolbar. 
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The following palette of symbols will now appear. 
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Simply click on the one that you want, move the cursor onto the map itself and click on the location where you want the new pushpin to appear.

For an existing pushpin:

Click once on the pushpin that you want to alter.

Go to the Format menu.

Select Pushpin. The following window should now appear:
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Click once on the Symbol menu, and the palette of alternative symbols should appear.

Click on the one that you want, and then click OK.

Using demographic data

MapPoint 2001 comes with its own database of current demographic data. Information is provided in up to 50 categories, such as:

· Population

· Household income

· Household size

· Marital status of head of household

· Age of head of household

· Occupation of head of household

· Hobbies of head of household

Data is quite detailed, and is available down to the Postcode Sector level for Great Britain. 

Data is also available in varying levels of detail for other European countries:

· Austria

· France

· Germany

· Italy

· The Netherlands

· Spain

· Switzerland

Further data for the rest of the world is available, but is limited to national level (ie - regional and local data is not available).

Using Data

When mapping Demographic data in MapPoint it is not possible to review the data first. It is therefore necessary to use the Data Mapping wizard (described over page) to start creating a map and plot the data, and then make alterations (such as choosing a more appropriate map type) if necessary afterwards.

The Data Mapping Wizard

	The Data Mapping Wizard is the tool that we use to map data. Start it by clicking on the Data Mapping Wizard button:
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You should now see the first stage of the Data Mapping wizard:
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Here, you need to chose one type of map from the four displayed.

Shaded Area Map

This is most suited to large areas of coverage such as counties or postcode areas. The darker the shade, the higher the value represented.

Sized Circle Map

This is more suited to smaller areas such as postcode sectors or individual addresses. The size of a circle indicates the value that it represents.

Shaded Circle Map

Here, the darker the shade of the circle, the larger the value. With shaded circle maps, all circles are the same size, which may make them more suitable when you want map detail to be visible.

Pushpin Map

Pushpin maps do not show data values, but can show individual locations or addresses.

To plot two sets of data on the same map it is possible to combine a shaded area map with either a sized circle or shaded circle map. 

Once you have chosen, click Next, and the next stage should appear:
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Ensure that Add demographics to the map is selected. 

Also ensure that the country that you require is also shown on the drop down menu directly underneath.

Click on Next, and the following screen should appear:
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This screen allows you to:

· Select data fields (categories)

· Divide or combine data

· Select the spatial unit by which data is shown (for example, Postcode Area)

At this stage it may be appropriate to avoid dividing or combining data. Simply select the data field and spatial unit, and click on Next.

The following screen should now appear:
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This screen allows you to alter the way in which the data is displayed. 

The Range Type menu allows you to choose the data range that you want to use. A variety of options are available. Unless you have reason to change this, leave the selection as Continuous range. 

You also have the opportunity to alter the title that MapPoint gives by default. Simply click into the Map Title box (above) and type in a more appropriate title.

Click Finish. MapPoint should now produce a map of your data:
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Once your map is complete, it is possible to alter it. See the section below on page 38, Editing data maps.

Importing data

For data to be imported and used successfully in MapPoint it has to be prepared beforehand in a format that will allow MapPoint to plot it geographically. Data can be imported from a variety of sources, including Access databases, Excel spreadsheets and several text file formats. The instructions that follow demonstrate how to import data from a spreadsheet file created in Excel, as this is arguably the most user friendly format to use.

MapPoint uses a variety of different methods to plot data. For Great Britain the most useful and easiest to use are the spatial units given below:

· Postcode Sector (eg NG9 1)

· Postcode District (eg NG9)

· Postcode Area (eg NG)

· County (eg Nottinghamshire)

· Country / Region (eg United Kingdom, France)

It is therefore necessary to include a column of data in your spreadsheet that contains data that falls into one of these categories, so that MapPoint knows where to put each item of data when it plots it onto a map. 

This means that it is necessary to plan an exercise before implementing it in MapPoint. It is important to consider the following points: 

1. Ensure that if comparing sets of data from different areas, that all data can be used with one particular spatial unit (for example, it may not be appropriate to compare one region of Post code District data to a region where data was given at county level).

2. Decide on a spatial unit that is appropriate to the data that you want to plot. 

Create your spreadsheet file

In Excel, create a new spreadsheet file (File menu, New). 

Excel normally gives a new spreadsheet file three worksheets, with Sheet1 ready to use. 
To check which sheet is in use, look for the sheet tabs at the bottom left hand corner of the spreadsheet, as shown below:
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Make a note of the worksheet that you are using, as this will make it easier to extract the data when using MapPoint later on. 

Column Headings

The first row of data in the spreadsheet needs to contain specific column headings. 

The first of these must contain a valid spatial unit such as County or Postcode Sector (see previous page). This must be spelt correctly.
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The second column heading should contain the title of the data that you are going to plot. Unlike the first column heading, this does not have to follow a specific format. However, including useful information such as dates or units of measurement may prove useful.
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Column One

Column one should contain valid data for the spatial unit that you have chosen. For example, if you are plotting data about counties, county names go here. In the case of our example, we are working with Post code sectors. 

If you are unsure if the units you are entering are valid (Post code data can be particularly tricky) then MapPoint will try to correct any mistakes you may have made later on, so it is sometimes necessary to have a trial run to see if MapPoint will accept your spatial unit data before trying to get it right.
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Column Two

	Column two contains the data that you want to plot.
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Once you have entered your data, save your spreadsheet. Make sure that you know where you saved it, because you will shortly need to access the data it contains.

The Data Mapping Wizard (again!)

	As when mapping Demographic data, we use the Data Mapping Wizard to map data imported from a data file. Start it by clicking on the Data Mapping Wizard button: 
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You should now see the first stage of the Data Mapping wizard:
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Here, you need to chose one type of map from the four displayed, described over page.

Here, you need to chose one type of map from the four displayed.

Shaded Area Map

This is most suited to large areas of coverage such as counties or postcode areas. The darker the shade, the higher the value represented.

Sized Circle Map

This is more suited to smaller areas such as postcode sectors or individual addresses. The size of a circle indicates the value that it represents.

Shaded Circle Map

Here, the darker the shade of the circle, the larger the value. With shaded circle maps, all circles are the same size, which may make them more suitable when you want map detail to be visible.

Pushpin Map

Pushpin maps do not show data values, but can show individual locations or addresses.

To plot two sets of data on the same map it is possible to combine a shaded area map with either a sized circle or shaded circle map.

Once you have chosen, click Next, and the next stage should appear:
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Select the option entitled Import data to map it and click Next. 

The following dialogue box should now appear, to enable you to select the data (spreadsheet) file that you want to use:
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Simply click on the file that you want, and click the Open button.

The next screen should now appear:
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Use this to select the Worksheet that you used to store your data when you created the spreadsheet (in this case, Sheet1)

Click Next, and the following screen should appear:
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You should not need to do anything here, as long as your spreadsheet contains a valid heading in the first row, and valid spatial data. 

However, it is possible that MapPoint has not recognized the spatial unit that you entered as the first column heading in you spreadsheet. If this is so, you may see a message such as No valid location headings are found. If so, select the heading that you want from the drop down menu for the first column that is shown.

Click on Finish, and the following window will briefly appear while the computer maps your data:
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Once this is complete, the following window should appear:
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This window exists primarily to ensure that the correct data column in your spreadsheet file is used. 

Assuming that you only had two columns to begin with (one containing spatial data and one containing the data you want to map) then you should not need to do anything. If however you have columns in the spreadsheet that contain additional information, this screen can be used to choose between them.

As long as the correct column heading is displayed at the top of this window, simply click on Next. 

The final stage in the Wizard will appear:
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This screen allows you to alter the way in which the data is displayed. 

The Range Type menu allows you to choose the data range that you want to use. Unless you have reason to change this, leave the selection as Continuous range. 

Alter the map Title if necessary, and click Finish. MapPoint should now produce a map of your data:
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Once your map is complete, it is possible to alter it. See the section on the next page, Editing data maps.

Editing Data maps

Once a map is complete it is possible to alter it. This section covers:

· Deleting data

· Changing Data fields 

· Editing the Legend

· Changing the Map Type

Deleting data

Right click on the map legend. A small floating menu should appear.

Click (either mouse button) on the Delete command. You should now see a confirmation dialogue box asking if you are sure you want to delete the data. Click on Yes to confirm. 

Note that if you have mapped more than one set of data, it is important to select the correct data set in the legend by right clicking on the part of the legend that relates to the data set that you want to delete.

Changing Data fields

Right click on the map legend, and a small floating menu should appear. 

Click (either mouse button) on the Data fields command and the second screen from the data mapping wizard should appear. Note that this will vary depending upon whether you are working with demographic data, or your own imported data. 

You will now be able to change the category of data that you want to work with, and the spatial units that are used to map it. 

Once you have made your changes, click on Finish to confirm, and MapPoint will re-map your data.

Editing the Legend

Right click on the map legend, and a small floating menu should appear.

Click (either mouse button) on the Format Legend command and the wizard will re-appear at the final screen:
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You can now make alterations such as changing the Title, range type, colour used or Legend Label. Click Finish to confirm your changes.

Changing the Map Type

Right click on the map legend, and a small floating menu should appear. 

Click (either mouse button) on the Map Type command and the first screen from the data mapping wizard should appear: 
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Select a different map type and click Finish.
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